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0. BACKGROUND 
This user guide is based on the IPD platform for e-filing.  References to Interactive Services 
in the related settings of web sites and other documentations, e.g. terms of use for e-filing, are 
updated. E-filing system can also be used by non-admin users (for windows). (Please note 
that admin user (for windows) will be required for setting up before non-admin users can use 
the E-filing system.) 
 
 

1. INTERACTIVE SERVICES AND ELECTRONIC FILING 
To use Interactive Services and Electronic Filing (E-Filing), apply to IPD for a Customer ID 
and a User Account.  This requires you to obtain an application form, complete it and convert 
it to an XML file. Then sign the generated XML file, verify it and then submit it to IPD. 
 
There are two types of User Account for every Customer ID: the Web User and the Admin 
User. Both these types have access to all the normal services provided by the E-Filing System.  
The main difference between them is that the Admin User has access to additional services.  
Only the Admin User can apply for additional User Account(s) and suspend / un-suspend 
User Account(s) under the same Customer ID (see "Admin User Guide" for details). 
 
On IPD approval, you will be given a Customer Account ID with one Web User Name and its 
password for logging onto the E-Filing screens. 
 

1.1 APPLICATION FOR INTERACTIVE SERVICES AND ELECTRONIC FILING 
SERVICES 

1.1.1 Downloading and Completing the Application for e-Filing Form 

The Downloads screen contains Application for e-Filing Services Forms and Trade Mark 
Forms, Design Forms and Patent Forms. The set of forms available for each registry is 
separated into two categories: Interactive Forms and E-Forms. You can download these 
forms, which are MS Word macro templates, to generate XML files for submission to the 
IPD Interactive Services and Electronic Filing Web Site.  The Downloads screen also 
contains XML Schemas and an application for signing XML documents offline.  The XML 
schemas can also be downloaded so that you can create XML files using your own 
application. 
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Instruction 

1. Go to Downloads in the E-Filing Home screen.  

 
 

E-Filing Home Page 
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2. Under "Section A. Application Forms", click Application for e-Filing Services. You can 
open or save the downloaded application form, which is an MS Word template.  If you 
immediately open the application form, choose "Enable Macro". 

Note: Please save the templates in ".dot" format. This is to ensure that all of the macro 
components are working correctly. 

 

 
Downloads 
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Note: For MS Word 2003 and XP users, if you saved the downloaded application form first, 
then later when you open the form, set MS Word XP or 2003 to enable macro settings.  
Modify the macro security setting in Tools -> Macro -> Security -> Security Level... -> 
Choose Medium or Low -> click OK twice to confirm setting.  

For MS Word 2007 users, save the downloaded application forms into a "trusted location". 
To specify a "trusted location" for Word 2007, click the Office Button >> click Word 
Options >> click Trust Center >> click Trust Center Settings >> click Trusted Locations 
>> click Add new location (tick Subfolders of this location are also trusted if you want 
Word 2007 to consider these subfolders as "trusted locations" also). 

3. Complete the form:   

3.1. Click the grey areas in each field and type required information.   

3.2. Input at least one Preferred User Name (maximum of five users) and your e-mail 
address.   
 
Note: Only PDF files are accepted as attachments. (PDF versions up to 1.7 are 
supported) 
 

4. After completing the Application for e-Filing Services Form, convert it to XML format 
by clicking  on the toolbar.  

4.1. On Please input source destination (*.xml) screen, in the Destination field, input 
the filename and location where you want to save the XML file that will be 
generated.  

4.2. Click OK.  
 
Note: After clicking OK, a message is displayed to confirm if conversion is 
successful. You can also set a default export path if you want other XML files to be 
saved in the same location (see "Introduction to The Electronic Form Template" for 
details).   
 
 

1.1.2 Submitting the Application for e-Filing Services Form to IPD 

After accomplishing and preparing the XML file, you need to submit it online to IPD through 
the Application for e-Filing Services screen.  Once your online application has been 
approved by IPD,  you will be given a Customer ID and a Web User account.   
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Instruction  

1. From E-Filing Home screen, select Application for e-Filing Services.   
 

 
 

Application for e-Filing Services 

2. Input the location and file name of the XML file you prepared in the Application 
Filename, or click Browse, then find and select the XML file from the dialog box.  
 
Note: The XML file still has to be "signed" by an electronic certificate.  This is done as a 
security measure when you submit your application online to IPD.  If you used the Word 
template provided by IPD, these electronic form templates are NOT yet "signed".   
 
 A program for signing applications is provided in the Downloads screen (Please see 
"Introduction to Electronic Submissions" for details). 
The system checks if you have installed the required component for signing.  The system 
will prompt you to confirm whether you have installed this required component.  The 
system will also display a warning message if your browser settings do not allow it to 
install or run the signing component.  

Note: The system would automatically download and install the required component for 
signing when you first browse the Downloads or Application for e-Filing Services 
screens. (The download process may take some time if your Internet connection is slow). 
Your browser must have the following Security Settings:  

For Internet Explorer 7.0 

•  Download Signed ActiveX Control set to Prompt or Enable  
•  Script ActiveX Controls Marked Safe for Scripting set to Prompt or Enable  
•  Cookies enabled 
 

2

3.13.2
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Note: Additionally for Windows Vista Users, please add the E-filing Website to the List 
of Trusted Sites (Internet Explorer -> Internet Explorer (Options) -> Security -> Trusted 
Sites -> click Sites -> specify E-filing Web Address -> click Add) 

 
3. Sign your XML application form:  

3.1. If your XML application form is not yet signed, click Sign & Upload to sign the 
file.  

3.2. If your XML application form is already signed either by using the offline signing 
application provided in the Downloads screen, or with your own signing program, 
you should click the Upload.   
 
Note: After uploading the Application for e-Services Form, the system will extract 
your application details from the XML file, and display the data extracted on a 
Confirmation screen.  If data is not correctly input, you have to make corrections 
to the original (not signed) XML file or change the eform and generate a new XML 
file.  
 

4. On the Confirmation screen, check if the data is correct.  

 
 

Application Confirmation 
 

Note: If you want to change the details of the application you intend to submit, click 
Return to Previous Screen and make the appropriate changes.  
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5. Click Submit 

 
Note: IPD will need time to process your application.  Once the application is approved, 
you will receive an acknowledgment e-mail at the e-mail address you specified. This will 
include your Customer ID with an individual User Name and password.  Use the User 
Name and password to log into the system. 
 

 
 

Application for e-Filing Services Submission Message 
 
 
 
 
 

 
 
 
 

1.2 LOGIN  

You need log into the system before you can access Interactive Service and Electronic Filing 
screens.  However, you do not need to login to access Downloads, Application for e-Filing 
Services, Related Links, and Help screens. As for the Admin User page, the Admin User 
has to login to make it available.  
 
Instruction  
1. Go to E-Filing Home screen, click Login.  
 
2. Input Login information. The following mandatory fields must be entered: 
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2.1. User Name 
2.2. Password 

 

 
 

Log In 
 
3. Click Login or press "Enter".  

 
Note: For users of Internet Explorer 7, in Windows Vista environments you may need to 
disable the option that "Enables Protected Browsing" by going to Internet Explorer -> 
Tools -> Internet Options -> Security tab -> then untick Enable Protected Mode and 
click Apply. This is for when you encounter errors during login. 

 
Note: Once you login for the first time, you will be prompted to change the password (see 
"Change Password" for details).  Otherwise, you cannot proceed to the E-Filing screens 
that requires login until the password has been changed. 
 
Note: Click Reset to clear User Name and Password. 

 

1 

1
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1.3 LOGOUT  

Instruction  
1. Click Logout.  
 

 
 

Logout 
 
2. Click OK in the dialog box.  
 
3. Click OK in the second dialog box that confirms successful logout.  

 
Note: After logging out, you are redirected to the E-Filing Home screen. 

 

1 
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1.4 CHANGE PASSWORD  

For security purposes, the system-generated password initially sent along with the approved 
Account Application is set to expire by default.  This is done, so that the system may prompt 
the user to immediately change the initial system-generated password.  
 
Instruction  
1. Click User Details.  
 

 
 

User Details 
 
2. Input User Details information. The following mandatory fields must be entered: 

2.1. Old Password  
2.2. New Password 

 
Note: The following are requirements for your password: 
• Minimum password length is 6 characters 
• Password must contain at least one letter of the alphabet 
• Password must contain at least one numeric digit 
• Password must contain at least one of the following special keyboard characters:    

(~`!@#$%^&*()_-+=|\{}[]:";<>,.?/) 
• Password validation is case insensitive 

 
2.3. Confirm Password 
 
Note: Click Reset to clear Old Password, New Password and Confirm Password.  
  

1 



 
USER GUIDE 
 

1-11  
 

3. Click Apply.  
 
Note: Click Cancel to stop changing password and close the screen. 
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1.5 APPLICATION FOR ADDITIONAL USER ACCOUNTS  

The first user who applies for the Customer ID Account at IPD becomes the Admin User. 
IPD decides which of the users are granted Admin User rights.  
 
The Admin User has authority that enables him/her to manage the user accounts under the 
same Customer ID.  Only the Admin User of a Customer ID can apply for additional User 
Accounts, suspend or reactivate suspended user accounts under the same Customer ID (see 
"Admin User Guide" for details).  
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1.6 GENERAL CONTROLS  

General controls are links, buttons and icons that will allow you to carry out transactions, 
execute processing actions, view and navigate to screens of the E-Filing System.  General 
controls can be seen on most of the screens, or their appearance follows a specific pattern 
depending on what elements are displayed onscreen.   
 
 
1.6.1 Menu  

The E-Filing System menu is located at the left panel of the screen.  It is used to navigate to 
different major components or sections of the E-Filing System.  
 
Instruction  
1. Logon to the E-Filing System using your User Name and Password.  

 
Note: If you are not logged in, only Related Links and Help are the components that are 
available on the menu.  

 

 
E-Filing System Menu 

 
2. Click any link on the menu to arrive at its corresponding screen.   

 
Note: The IPD logo at the top of the menu is a link to the E-Filing Home page.  
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1.6.2 South East Buttons and Links 

South East buttons  and corresponding links are located at the bottom of screens.  These 
controls are used to go to other screens, execute a processing action, carry out transactions, 
apply filters and view documents or data.  
 
Instruction  
1. Logon to the E-Filing System using your User Name and Password.  
 
2. Click any South East button and its corresponding link to go to other screens, execute a 

processing action, carry out transactions, apply filters and view documents or data.  
 

 
 

 
Examples of South East buttons and corresponding Links 

 
Note: If you are not logged in, only Downloads and Application for e-Filing Services 
are the links that are available.  

 
 
1.6.3 Language Links 

You can easily change the language of E-Filing System screens - you can switch languages 
from English to Traditional Chinese with just a simple click of a link. Language links are 
located at the upper right corner of the banner.  After clicking a language link, the main 
screen and all its child screens are refreshed to display text in the language that you selected. 
Context on the main menu, captions, labels, and generated messages also change language. 
However, the language that was used to originally input data in the forms is preserved.   
 
Instruction    
1. Click  to switch to Traditional Chinese. 
 
2. Click  to switch to English.   
 
 
1.6.4 Navigation Links 

Navigation links are located at the top of the E-Filing System banner. Navigation links 
provide the name of the current screen you are currently viewing and previously visited 
screens. The name of the screens are links that you can click to go their respective screens.   
 
Instruction  
1. Click a screen name link to go to that screen.  
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Navigation Links 

 
 
1.6.5 Record Links 

After you have just retrieved a large number of records, the records result list usually do not 
fit in just one page.  Thus, if the records retrieved are too many, the records result list is 
displayed on a certain number of pages.  You can use the Record Links located immediately 
at the upper right corner of the records result list to navigate to these pages.   
 

 
Record Links 

 
Record Links are made up of <<, <, [page number], > and >> links.  They are only 
displayed when retrieved records exceed the number of records that can be displayed in a 
page.   
 
Instruction  
1. Click << link to display the first page of the records result list.   
 
2. Click >> link to display the last page of the records result list.    
 
3. Click [1][2][3][4][5] page number links to display the corresponding page number. 
 
4. Click < link to display the previous page.   
 
5. Click > link to display the next page.   
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1.7 RELATED LINKS  

This link directs you to the HK IPD (Hong Kong Intellectual Property Department) Web 
Site, IPD Trade Mark Search System, Design Search System, and Patent Search System. 
 
In the Trade Mark Search System you can search for Trade Mark records in the Trade 
Marks Registry to find out if there are any marks in the Trade Mark Registry which are 
similar to the one you intend to apply for registration.  If you know that your Trade Mark 
does not have any similarities with others, you can avoid submitting an application that may 
conflict with other Trade Marks that have been registered or are awaiting registration. 
 
Instruction  
1. From E-Filing Home screen, select Related Links.  
 

 
 

Related Links 
 
2. On Related Links screen, click Trade Mark Search System (see "Trade Mark Search 

System" for details).  
 
Note: Upon clicking Trade Mark Search System or Design Search System or Patent 
Search System, the search screen is displayed.  There are two main search screens in 
Trade Mark or Designs or Patent Search: Simple Search and Advanced Search.  

 

1 
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1.8 HELP  

The Help screen is used as a reference on E-Filing System components and how to use them.  
It contains comprehensible topics and simple instructions to guide you in using the E-Filing 
System effectively.  
 
1.8.1 Help screen 

 
Instruction  

1. From E-Filing Home screen, select Help.  
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Help (Table of Contents) 
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2. On the Help screen, click a Help topic link to display content of that topic.   
 
Note: If you are using a major component of the E-Filing System and then you click the 
Help, the system will display the Help topic associated with the screen you are currently 
viewing.  Thus, you save time instead of searching for topics.  
 
Note: If you click Help while the E-Filing Home screen is currently open, the system 
will display the Help file's Table of Contents.  Click any Help topic in the Table of 
Contents and you will learn more about the system and its functions. 

 
1.8.2 Roadmap screen 

A Roadmap screen is used to provide the Web User with information about the usage flow 
of the e-Filing System. It can be accessed through a link on the Online Help Table of 
Contents.  
 
Instruction 
1. From the Online Help Table of Contents, click Roadmap.  
 

 
Help (Roadmap) 
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2. Select and click the link of the particular component you want to go to.  
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2. INTRODUCTION TO THE ELECTRONIC FORM TEMPLATE 

The electronic form templates are application forms in Word format (".dot"), which generate 
XML files. XML formats are primarily machine readable formats. These XML files are then 
submitted to IPD, through our E-Filing Web Site. Currently, the templates only support MS 
Word 2000, MS Word XP, MS Word 2003 and MS Word 2007. English Version, Traditional 
Chinese Version and Simplified Chinese Version of MS Word are supported. 

 

2.1 GENERATING XML FILES USING THE ELECTRONIC FORM TEMPLATE 
 
Instruction  

1. Go to Downloads in the E-Filing Home screen. Download the Electronic Form 
Template.  
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Downloads 

2. Ensure that the Macro template is enabled in your Microsoft Word. To modify the macro 
security settings, select Tools -> Macro -> Security. On the screen, select the Security 
Level tab and choose Medium or Low.  Click OK to confirm the setting. 

For MS Word 2007 users, save the downloaded application forms into a "trusted 
location". To specify a "trusted location" for Word 2007, click the Office Button >> 
click Word Options >> click Trust Center >> click Trust Center Settings >> click 
Trusted Locations >> tick Add new location (tick Subfolders of this location are also 
trusted if you want Word 2007 to consider these subfolders as "trusted locations" also). 

3. Open the electronic form template.  

Note: Choose Enable Macro if your macro security setting is Medium 

4. Click on the grey area within a field and type in the information.  

 
Sample Electronic Form 

 
5. To specify a country, click on the grey area in the Country field and a country list 

appears for you to choose from. 
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Select Country 
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6. Some fields (e.g. Application Number, Class Specification, etc.) can accept more than 

one entry.  Click Add to add a new row or click Remove to delete the last row.  

Note: On Click of Remove all the data in the last row will be removed. 

 
Add / Remove Button 

 
7. To tick a checkbox, click on the box and an ‘X’ will be displayed. 

 
Checkboxes 

6
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8. To embed attachments into the electronic form, enter the path and filename of your 

attachments in the box provided.  

 
Specifying File Name and Location 

Note: Attachments supported by the templates include JPEG (*.jpg), PDF (*.pdf) and text 
(*.txt) file formats. For text file attachments, the electronic form expects its content to be 
a comma and/or new line delimited list of values. For example, if the attachment contains 
application numbers, the following text:  

199780045, 300001678, 899976509  

456254543, 143440000 

will be treated as five different application numbers. 

 
Audio / Video File Attachments 

 

Note: Specific E-forms such as TC (e-Filing for Trade Marks Correspondence) and T2 
(Application for Registration of a Trade Mark) will have specific attachment fields that 
can support Audio/Video File attachments. To attach Audio/Video files, specify the 
complete path and filename of the file to be attached. Note that as of the moment only the 
following filetypes of Audio/Video attachments (.wav, .mp3, .mpeg and .wmv). The e-
Filing system will validate the filetypes of the attachments and will also check the 
validity of the audio/video attachments as part of the e-Filing e-form validations on 
upload. 

 

9. When all the information is ready, press the  Convert to XML icon  on the toolbar / 
ribbon to generate the XML file.  Depending on the size of the attachments, the time 
taken for the generation of the XML file will vary. 

Note: It is recommended that you save the file before generating the XML document by 
clicking File -> Save As… and then input the desired filename. 
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The Convert to XML button 

 
10. Input the desired filename of the XML file and its path (e.g. 

C:\XMLPath\MyFirstXML.xml). To avoid inputting the file path every time, a default 
path function is available enabling the setting of a default export path for the XML file. 
Please refer to the "Setting a Default Export Path" section for details. 

 
Specifying File Name and Export Path for the XML File 
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11. A confirmation message is displayed if the conversion is successful.  
 

 
Conversion Successful  

 
12. The XML file will be available at the location specified in step 10. (e.g. 

C:\XMLPath\MyFirstXML.xml) 

 

2.2 SETTING A DEFAULT EXPORT PATH 

You can set the default export path for an electronic form template by using the set default 
path function.  This means that you do not have to input the export file path each time an 
XML file is generated. 
 
Instruction 

1. Save the electronic form template. 

2. Click the Set Default Path button  

 
     Set Default Path Button 

 
3. Input the default export path and then press OK.  
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Specifying Default Export Path / Directory 

 

4. After saving the default path, whenever you click the Convert to XML button, the 
default path is displayed and highlighted in the box.  A default export path will be set up 
only for that particular E-form; so, you still need to repeat this procedure if you need to 
set up default export paths for other E-forms.  

 
Default Path Displayed after Clicking Convert to XML Button 

 

2.3 UNDERSTANDING THE XML SCHEMAS 

The XML schemas are documents that use XML syntax to define the elements that can 
appear within an XML document and the attributes that can be associated with an element. It 
also defines the structure of the XML document like: which elements are child elements of 
others, the sequence in which the child elements can appear, and the number of child 
elements. It defines whether an element is empty or can include text. The XML schema can 
also define default values for attributes.  XML schemas are mainly used for validating the 
correctness of the XML document and serves as a guide on creating XML documents to the 
system. 
 
By May 2006, there is no specific XML standard from OGCIO for the IP industry. The XML 
standard used are defined explicitly for this system. 
 

File Name Description 
coretype.xsd Contains the base or primitive types to be used in the XML 

schema 
xmldsig-core-schema.xsd Contains the definitions for XML Signature 
CustomerID.xsd Contains definitions used for Application for e-Filing Services 
WebUser.xsd Contains definitions used for Application for e-Filing Services - 

User Account 
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File Name Description 
Trade Mark Schema
tmlr-implementation.xsd Contains the complex types to be used in the XML Schema of 

Trade Mark Forms 
tmlr-business.xsd Contains generic definitions for Trade Marks Forms 
eform.xsd The XML Schema used to validate the Trade Mark Forms 
E-Forms 
FormT1.xsd Contains definitions used for T1 - Request for Search of 

Records/Request for Preliminary Advice on Registrability 
FormT2.xsd Contains definitions used for T2 - Application for Registration of 

a Trade Mark (Including Certification Mark, Collective Mark 
and Defensive Mark) 

FormT3.xsd Contains definitions used for T3 - Request to Divide Application 
for Registration 

FormT4.xsd Contains definitions used for T4 - Request to Merge Applications 
for Registration/Request to Merge Separate Registrations 

FormT5.xsd Contains definitions used for T5 - Request to Change Name, 
Address, Address for Service or Agent's Address (for Licensee or 
Person having an Interest in the Mark) 

FormT5A.xsd Contains definitions used for T5A - Request to Amend 
Application 

FormT5B.xsd Contains definitions used for T5B - Request to Amend 
Representation of Trade Mark/Request to Delete Trade Mark in 
Series 

FormT8.xsd Contains definitions used for T8 - Request for Restoration and 
Renewal of a Trade Mark Registration 

FormT9.xsd Contains definitions used for T9 - Surrender of Registered Trade 
Mark 

FormT10.xsd Contains definitions used for T10 - Application or Notice to 
Register a Court Order or a Security Interest/Request to Amend 
or Remove Registered Particulars of Security Interest 

FormT11.xsd Contains definitions used for T11 - Application or Notice to 
Register a Licence/Request to Amend or Remove Registered 
Particulars of a Licence 

Correspondence.xsd Contains definitions used for TC - E-Filing for Trade Marks 
Correspondence 

Interactive E-Forms 
FormT5i.xsd Contains definitions used for T5i - Request to Change 

Applicant's/Owner's Name, Address, Address for Service or 
Agent's Address 

FormT8i.xsd Contains definitions used for T8i - Request for Renewal of a 
Trade Mark Registration  

FormT10i.xsd Contains definitions used for T10i - Application or Notice to 
Register an Assignment / a Transfer or an Assent 

FormT13i.xsd Request for Extension of Time 
Design Schema 
dras-implementation.xsd Contains the complex types to be used in the XML Schema of 

Design Forms 
dras-business.xsd Contains generic definitions for Design Forms 
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File Name Description 
eformDRAS.xsd The XML Schema used to validate the Design Forms 
E-Forms  
FormD1.xsd Contains definitions used for D1 - Application for Registration of 

Designs 
FormD2.xsd Contains definitions used for D2 - Request to Amend an 

Application/Request to Correct an Error in the Register or in 
Filed Documents 

FormD3.xsd Contains definitions used for D3 - Request for Reinstatement of 
Application 

FormD4.xsd Contains definitions used for D4 - Application for Extension of 
Time 

FormD5.xsd Contains definitions used for D5 - Application to Register 
Particulars of Transactions Affecting Rights in Registered 
Designs/ Notice of Transactions Affecting Rights in 
Applications/Application to Cancel Claim to be Mortgagee or 
Licensee 

FormD8.xsd Contains definitions used for D8 - Notice to Surrender 
Registration 

FormD11.xsd Contains definitions used for D11 - Application for Renewal of a 
Registered Design 

FormD12.xsd Contains definitions used for D12 - Request for Alteration of 
Name, Address, Address for Service or Agent's Address (for 
Persons Other Than Applicant/Registered Owner)/Request for 
Correction of Address, Address for Service or Agent's Address 

FormDC.xsd Contains definitions used for DC - E-Filing for Designs 
Correspondence 

Interactive E-Forms 
FormD12i.xsd Contains definitions used for D12 - Request for Alteration of 

Applicant's/Registered Owner's Name, Address, Address for 
Service or Agent's Address 

Patent Schema 
epatcom-
implementation.xsd 

Contains the complex types to be used in the XML Schema of 
Patent Forms 

epatcom-business.xsd Contains generic definitions for Patent Forms 
eformEPATCOM.xsd The XML Schema used to validate the Patent Forms 
E-Forms 
FormP4.xsd Contains definitions used for P4 - Request to Record a 

Designated Patent Application for a Standard Patent 
FormP5.xsd Contains definitions used for P5 - Request for Registration of a 

Designated Patent and Grant of a Standard Patent 
FormP6.xsd Contains definitions used for P6 - Request for a Grant of a Short-

term Patent 
FormP7.xsd Contains definitions used for P7 - Request for Correction of 

Error/Request to Publish a Corrected Translation 
FormP8.xsd Contains definitions used for P8 - Request to Make an 

Amendment 
FormP12.xsd Contains definitions used for P12 - Application to Restore a 

Withdrawn Standard Patent Application Due to Non-Payment of 
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File Name Description 
Maintenance Fee/Application to Restore a Lapsed Standard 
Patent/Application to Restore a Lapsed Short-term Patent 

FormP13.xsd Contains definitions used for P13 - Notice Requesting 
Reinstatement of a Patent Application/Application for 
Restoration of Rights 

FormP16.xsd Contains definitions used for P16 - Notice of Offer to Surrender 
a Patent 

FormP18.xsd Contains definitions used for P18 - Request for Alteration of 
Name, Address, Address for Service or Agent's Address (for 
Persons Other Than Applicant/Proprietor)/Request for Correction 
of Address, Address for Service or Agent's Address 

FormP19.xsd Contains definitions used for P19 - Application for Registration 
or Notice to the Registrar of Rights Acquired in or Under a 
Patent or a Patent Application 

FormPC.xsd Contains definitions used for PC - E-Filing for Patents 
Correspondence 

FormSP3.xsd Contains definitions used for SP3 - Request for Extension of 
Time/Paying Penalty Fee for Late Filing of Translation 

Interactive E-Forms 
FormP9P10i.xsd Contains definitions used for P9/P10 - Request for Renewal of a 

Patent/Maintaining Application for Standard Patent 
FormP18i.xsd Contains definitions used for P18 - Request for Alteration of 

Applicant's/Proprietor's Name, Address, Address for Service or 
Agent's Address 

 
Note: 
1. The XML Schemas can be downloaded at the Downloads of the E-Filing Home screen. 
2. Files will be in zip format (*.zip). 
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3. INTRODUCTION TO ELECTRONIC SUBMISSIONS 

After your Customer ID and Web User Account application has been approved by IPD, you 
can upload, submit and pay for applications via our E-Filing System. 

You need to upload the XML documents of your application onto the system. The system 
will extract the data from the documents and then generate the PDF files for preview. After 
previewing the application, you may submit and pay for your application to IPD. 

Interactive Forms are processed by IPD immediately upon upload. For more information 
regarding these applications, please see "Introduction to Electronic Submissions (Interactive 
Services)" for details. 
 
3.1 PREPARING AND UPLOADING APPLICATIONS  
 
Instruction  

1. Click Downloads on the Electronic Filing Home page. 

 

 
 

Electronic Filing Home Page 
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2. Prepare the required XML file for submission 

a. If you are using the Word template provided by IPD 

i. Download the desired Trade Mark Form, Design Form or Patent Form under the 
heading E-Forms from Section B, C and D respectively. 

ii. Complete the form and generate the required XML (see "Introduction to the 
Electronic Form Template" for details). 

b. If you are generating XML files using your own XML applications 

i. Download the desired XML Schemas in Section E. 

ii. Extract all schema files into any directory. 

iii. Create an XML document using eform.xsd, eformDRAS.xsd, 
eformEPATCOM.xsd together with the desired elements (formT1, formD1, 
formP4 … etc.). 
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2b 

2a 
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Downloads page 
 

3. Go to the E-Filing Home page and login with your User Name and Password (see " 
Application for Electronic Filing Services" for details). 

4. Click E-Submission from the main menu on the left hand side.  

Note: The "File List Ready for Submission" page will be displayed. It contains all the 
files previously uploaded under the same customer ID and the corresponding status.  

5. Click Upload at the bottom of the screen. The Upload page will be shown.  

 

 
 

File List Ready for Submission 
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6. Specify the number of applications to be uploaded. 

7. For each application, specify the location of the XML file in the text box or select the 
XML file by clicking the Browse button. 

Note: Interactive and non-interactive applications can be uploaded simultaneously. 

Note: The deposit account option is used only by interactive applications. It has no effect 
on non-interactive applications. 

8. If the XML is not signed, click the Sign & Upload button. 

Note: If you are using Internet Explorer and you have only one certificate installed in 
your browser then your application will be signed using that certificate. Otherwise, you 
will be prompted to select a certificate. This process is similar to steps 5-7 in section 3.2 
"Signing Applications Offline." Finally, if there are multiple XML files then all XML 
files will be signed. 

XML documents generated by the Electronic Form Templates are NOT yet signed. 

The system will check if the user has installed the required component for signing. The 
user may need to confirm the installation if the required component is not installed yet. 

9. However, if the XML document is already signed by the user application or by the offline 
signing tool available in the Downloads page (please refer to "Signing Applications 
Offline" for details), click the Upload button. 
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Upload page 

Note: After the upload has been completed, the application will be inserted into the File 
List Ready for Submission with a status of "Under Processing". Depending on the 
current loading of the system, it may take some time to process the XML documents and 
generate the PDF files for review. E-filing would try to process the uploaded application 
for 20 times until the validation is completed. If there were errors encountered or the 
XML could not be processed after 2 times then the status would be updated to 
"Validation Failed". 

 
Note: Note that the E-filing system will now validate the filesize of the XML documents 
uploaded. Please try to limit the number and size of attachments in the e-Forms to avoid 
your applications from failing the validation. 
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3.2 SIGNING APPLICATIONS OFFLINE 

You may use the HTML Signing Applications to perform offline signing. These tools are 
useful in signing E-Filing applications specially when more than one signature is required. 
For example, you can use this tool to sign your user account application and hand over the 
signed XML file to your Administrator. 
 
Instruction  
 
1. From the Downloads download the HTML Signing Application for Internet Explorer. 

2. The File Download window will appear. Save and extract the contents of the zip file to a 
local directory. 

 
 

Downloads page 

3. Open the file sign_offline.html. (For Windows Vista Users, please disable User Account 
Security the first time the Offline Signing Function is opened to allow the components to 
be installed.) 
 

4. Specify the location of the XML file to be signed in the field or select the XML file by 
clicking the Browse button. 

1

2
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5. Click Sign 

 

 

 
 

Offline Signing page 
 
6. Select the appropriate certificate and click OK.  
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Select Certificate for Internet Explorer 

 

7. The selected XML is now signed with the chosen certificate. Note that a backup copy of 
the unsigned XML has been created with the file extension .orig. 
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3.3  REMOVING UPLOADED APPLICATIONS  

You can remove the uploaded applications before they are submitted. 

Instruction  

1. Go to the File List Ready for Submission page. 

2. Tick the checkbox beside the uploaded application(s) to be removed.  

Note: Items with a status of "Under Processing" or "Not Yet Paid" cannot be removed. 

3. Click Remove to remove the selected applications. 

 
File List Ready for Submission with checkbox ticked. 
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3.4 PREVIEWING AND SUBMITTING UPLOADED APPLICATIONS 

The system processes the uploaded applications in batches. It validates the signature, XML 
documents and generates PDF files for preview. If the submission fails during the validation 
process, details of the error can be viewed by clicking Status. Once the status of an 
application changes to "Ready to Submit", you can submit the application to IPD via the E-
Filing page. 
 
Instruction 
1. A PDF file is created for the applications that you have uploaded. Click the hyperlink in 

the Form Name column to preview an application. (It is recommended that you preview 
your applications before submission) 

 
Note: For selected e-Forms (e.g. T2, TC, Patent and Design e-Forms) clicking the 
hyperlink in Form Name column will display the list of files included in the application. 
Clicking on the individual hyperlink in Document Type will select the file for download 
and/or open. For Audio/Video Attachments the default Media Player will be called to 
open the selected file if available, check the settings in the local machine for details. 

 

 
Documents List 
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2. Applications with a status of "Validation Failed" cannot be submitted. To find out the 
cause of the failure, click on the corresponding hyperlink under the Status column. This 
will open the Failure Reason screen listing the causes of failure. 

 
3. Add the desired application to the Online Cart by clicking the  icon. Only applications 

with a status of "Ready to Submit" or "Not Yet Paid" can be added. 
 
4. To check the contents of the online cart without adding any application, click on View 

Online Cart. 
 

 
 

Files List Ready for Submission 
 
5. Payment maybe deferred for some applications. When deferring payment for an 

application is allowed, un-tick the Pay? checkbox to defer payment of fee for that 
application. 

6. Simply repeat steps 3 – 5 to add more items to the Online Cart.  You can also click the 
Add All to Online Cart button to add all “Ready to Submit” items to the Online Cart. 

 

7. To remove an item from Online Cart, simply click the  icon beside the application in 
Online Cart.  

 
Note: Click Remove All From Cart to remove all the application from the Online Cart. 
Please note that the items are removed from Online Cart only and not from the File List 
Ready for Submission. 
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8. After adding all the desired items to the Online Cart and if there are no fees to be paid, 
click Submit to proceed. 

 

 
Online Cart 

 
9. Otherwise if there are fees to be paid, you will see the Next button instead of the Submit 

button. Click Next to go to the Select Deposit Account page.  
 
10. Choose the deposit account that you want to pay with.  
 
11. Click Pay and Submit to confirm payment and proceed. A modal window showing 

"Request is being processed... Please don't close this window." is displayed. Please wait 
for the processing to finish and the message to close before proceeding with the 
remaining processes. 

 
Note: The system will process the submission and validate the signature. The Submission 
Details page is then displayed if the submission of the applications was successful. 
Otherwise, another page informing you of the cause of failure will be displayed. A 
successful submission of applications means that the IPD received the applications and 
will consequently be processed. 
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Select Deposit Account 

 
Processing Submission 
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Submission Details 

 
12. Click the  icon under the Receipt column in order to view the receipt for that 

application. This receipt affirms that IPD has received the application together with the 
attached documents. To print the receipt, click on  on the receipt screen. 

 
13. If there is more than one submitted application then the Print All Receipt hyperlink will 

be available. Clicking on this link will show all receipts for that submission. Clicking on 
the  icon prints each receipt on a separate page. 

 
14. If you wish to review the application that you submitted together with its attached 

documents, click the form name under the Form Name column. 
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3.5 VIEWING THE SUBMISSION LOG 

The system logs every submission (both successful and failed) for a Customer ID. You can 
view the submission logs after you have logged in.  
 
Instruction  
1. From E-Submission page, click View Submission Log. The Submission Log will be 

displayed. Submission Log items are arranged by Submission Date in descending order 
and Submission ID. 

 
2. Click the hyperlink in the Submission ID column to view the submission details. (see 

"Previewing and Submitting Uploaded Applications" for details.) 
 
3. If you wish to review the application that you submitted together with its attached 

documents, click the form name under the Form Name column. 
 

Note: For non-interactive applications, the field Transaction Status will always contain 
the word “N/A”. 

 
Submission Log 
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4. INTRODUCTION TO ELECTRONIC SUBMISSIONS 
(INTERACTIVE SERVICES) 

After your Customer ID and Web User Account application has been approved by IPD, you 
can upload, submit and pay for applications via our E-Filing System. 

With interactive services, applications are submitted to the E-Filing System upon upload. 
Fees for applications that require payment are automatically deducted from a specified 
deposit account after the applications have been successfully processed by the system.  

For information regarding non-interactive applications, please see "Introduction to Electronic 
Submissions" for details. 
 
4.1 UPLOADING AND SUBMITTING APPLICATIONS  
 
Instruction  

1. Click Downloads on the Electronic Filing Home page. 

 
 

Electronic Filing Home Page 
 
2. Prepare the required XML file for submission 

a. If you are using the Word template provided by IPD 

i. Download the desired Trade Mark Form, Design Form or Patent Form under the 
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heading Interactive Electronic Records from Section B, C and D respectively. 

ii. Complete the form and generate the required XML (see "Introduction to the 
Electronic Form Template" for details). 

b. If you are generating XML files using your own XML applications 

i. Download the desired XML Schemas in Section E. 

ii. Extract all schema files into any directory. 

iii. Create an XML document using eform.xsd, eformDRAS.xsd, 
eformEPATCOM.xsd together with the desired elements (formT8i, 
formP9P10i … etc.). 
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Downloads page (English) 

2a 

2a 

2a 

2b 
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Downloads page (Chinese) 

2a 

2a 

2a 

2b 
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3. Go to the E-Filing Home page and login with your User Name and Password (see " 

Application for Electronic Filing Services" for details). 

4. Click E-Submission from the main menu on the left hand side.  

5. Click Upload at the bottom of the screen. The Upload page will be shown.  

 

 
 

File List Ready for Submission 
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6. Specify the number of applications to be uploaded. 

7. For each application, specify the location of the XML file in the text box or select the 
XML file by clicking the Browse button. If any one of the applications to be uploaded 
requires payment, the user can specify which deposit account to pay with through a 
combo box in the page. 

Note: Interactive and non-interactive applications can be uploaded simultaneously. 

Note: The deposit account combo box is available only to users with active deposit 
accounts. If the current user no active deposit accounts, then the combo box is disabled.  

8. If the XML is not signed, click the Sign & Upload button. 

Note: If you are using Internet Explorer and you have only one certificate installed in 
your browser then your application will be signed using that certificate. Otherwise, you 
will be prompted to select a certificate. This process is similar to steps 5-7 in section 3.2 
of "Introduction to Electronic Submissions (Non-interactive Services)".  Finally, if there 
are multiple XML files then all XML files will be signed. 

XML documents generated by the Electronic Form Templates are NOT yet signed. 

The system will check if the user has installed the required component for signing. The 
user may need to confirm the installation if the required component is not installed yet. 

9. However, if the XML document is already signed by the user application or by the offline 
signing tool available in the Downloads page (please refer to section 3.2 of "Introduction 
to Electronic Submissions (Non-interactive Services)" for details), click the Upload 
button. 

10. If the upload fails for a certain number of times, the error "XML file cannot be processed. 
Please contact your system Administrator." is logged and the xml is not uploaded. 
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Upload page 

 

Note: After the upload has been completed, the application will be inserted into the 
Submission Log with a status of "Under Processing". 
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4.2 VIEWING SUBMITTED APPLICATIONS 

The system logs every submission (both successful and failed) for a Customer ID.  You can 
view the submission logs after you have logged in. For interactive applications, after upload, 
the applications will be placed here with an initial status of “Under Processing” while the 
system processes them. 

The system processes the uploaded applications in batches. It validates the signature, XML 
documents and generates PDF files for preview. If the submission fails during the validation 
process, details of the error can be viewed in the Transaction Details page.  
 
Instruction  
1. From the E-Submission page, click View Submission Log. The Submission Log will be 

displayed. Submission Log items are arranged by Submission Date in descending order 
and Submission ID. 

 
2. Click the hyperlink in the Submission ID column to view the submission details (see 

section 3.4 of "Introduction to electronic submissions (non-interactive services)" for 
details). 

 
3. If you wish to review the application that you submitted together with its attached 

documents, click the form name under the Form Name column. 
 
4. Once an application has been processed, the user can view the results in the Transaction 

Details page by clicking the Transaction Status link. In this page, details specific to the 
record, such as failures detected, application/registration numbers of records updated or 
requests bounced back, etc. are displayed. 
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Submission Log 
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Submission Log (Continued) 
 

 
 

Transaction Details 
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4.3 VIEWING INTERACTIVE RECEIPTS 

When an interactive application has been successfully processed, a PDF version of the receipt 
is generated and sent to the user’s Electronic Mail Box (see "Electronic Mail Box" for more 
details). Please note that the receipt is only generated if the application has been successfully 
processed by the system. 

 

Instruction: 
1. From the E-Submission page, click Electronic Mail Box. The Electronic Mail Box 

page will be displayed. 
 
2. Select the registry of the application whose receipt you want to view. 
 
3. Click the “Interactive services receipt” link to view the PDF. 
 

 
 

 Interactive Services Receipt (Electronic Mail Box) 
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5. ELECTRONIC MAIL BOX 
The Electronic Mail Box page is used to receive and view letters and other related matters 
about your trade mark, patent and design applications and registrations from IPD. 
 

5.1 VIEWING LETTERS IN THE ELECTRONIC MAIL BOX 

 
Instruction 
1. Go to the E-Filing Home page, and log in using your User Name and Password (see 

"Login" for details).  
 

2. Click Electronic Mail Box at the menu on the left.  
 
3. Letters sent by IPD related to Trade Mark records are displayed by default. Letters related 

to Design records and Patent records can be viewed by changing the value of the Registry 
drop down list accordingly. 

 
Note: Electronic Mail Box records are sorted by IPD Sent Date/Time in descending order. 
Unread letters are in bold, while documents previously opened or read are in normal font. 
You may use filters (see "Using Filters" below for details) to display only those letters 
that you want to view and refer to.  

 
4. Click the Letter/Notice link to view the letter. A separate resizable screen with a menu 

bar and address bar will display the PDF version of the letter.  
 

Note: You can right click Letter/Notice and choose "Save Target As" to directly save the 
PDF without viewing it.  The letter/notice saved will not be marked as read unless you 
click the link and open the PDF from a separate window.   

 
5. Click Related Documents link to view the Related Documents of the application (see 

"Viewing Related Documents" below for details).  
 

Note: If the selected outstanding application does not link to your Customer ID, the 
Related Documents under this outstanding application will not be displayed as a 
hyperlink. This is to restrict access to the record under such circumstances. 
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Electronic Mail Box 
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5.2 REMOVING LETTERS FROM THE ELECTRONIC MAIL BOX 

 
Instruction  
1. Tick the checkboxes of the letters you want to remove.  
 

Note: Tick the topmost checkbox in the column to select all letters in that page.  
 

2. Click Remove at the bottom of the page. 
 

 
Removing Letters from Electronic Mail Box 
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5.3 USING FILTERS 

 
Filters are used to narrow down your search for the letters from IPD.  Filters are based on 
criteria that you define so that the system can search for letters that fall within such criteria. 
You can do any of the following:  
 

5.3.1. To display all letters 

 
Instruction  
1. Click Show All at the bottom of the page. When Filter Criteria at the top of the page 

indicates "None", this means no particular filter is applied. 
 

 
Displaying All Letters 

 

5.3.2. To add a filter 

 
Instruction 
1. Click Modify Stored Filter. 

 
2. In the Stored Filter screen, click Add.  
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Adding a Filter 

 
3. Select a filter category in the drop down list on the left. The filter options to the right will 

depend on the filter category you have chosen. 
 

 
Filter Options 

 
4. For text fields, type a keyword or type the date/period when the letters you want to view 

were most likely received. 
 
5. For drop down lists select the option that would fit the letters that you would like to 

search. Some filter categories provide a middle drop down list. This will define the 
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conditions under which the filter will operate in relation to the keyword or date you 
specified. The possible values are: 
 

a. For filters that are applied to texts:  
"exact" – you want to view letters that exactly match the status or keyword. 
"begins with"– you want to view letters that begin with the initial letters of the 
status or keyword. 
"contains" - you want to view letters that falls within the category of the  status or 
keyword.  

b. For filters that are based on dates:  
"=" letters received on the date you specified will be shown; 
"<" letters received before the date you specified will be shown; 
">" letters received after the date you specified will be shown; 
"<=" letters received on, or before the date you specified will be shown; 
">=" letters received on, or after the date you specified will be shown. 

 
6. After defining the conditions under which the filter will operate, click Save.  

 
7. You will be prompted to confirm if you want to save the filter record. Click OK. 

 
8. Stored Filters screen is displayed showing the new filter that you have just added. 
 

5.3.3. To remove a filter 

 
Instruction  
1. In the Stored Filter screen, tick the checkbox of the filters you want to remove. To select 

all filters for removal tick the topmost checkbox. 
 

2. Click Remove. 
 

 
Removing a Filter 

 
3. You will be prompted to confirm if you want to remove the selected filters. Click OK. 
 

5.3.4. To edit a filter 
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Instruction  
1. In the Stored Filter screen, click on the link corresponding to the filter you want to edit. 

Make the necessary changes (see "Adding a Filter" above).  
 

 
Editing a Filter 

 

5.3.5. To Apply a Stored Filter 

 
Instruction  
1. Click Apply Stored Filter. 

 
2. The records will be filtered according to the criteria in the Stored Filter. The criteria will 

appear as a bulleted list at the top of the page. 
 

 
Applying Filters 
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5.4. VIEWING RELATED DOCUMENTS 

 
The Related Documents page lists down documents that are related to an application that 
has been sent by IPD and customers. This page can be accessed through links provided at the 
following pages: Electronic Mailbox, Legal Limit, Related Matters, TM Details, Design 
Details and Patent Details.  
 
Instruction  
1. Click on the Letter/Notice link corresponding to the document you wish to see.  
 

Note: A related document may be in XML or PDF format. If your browser has a plug-in 
that supports the format of the selected document then the contents of the document will 
be displayed in a new window. Otherwise, you will be prompted to download the 
document. 

 
Note: You can right click Letter/Notice and choose "Save Target As" to directly save 
the document without viewing it. 

 
2. Click Return To Previous Screen at the bottom of the page or click on the navigational 

links above to go back to previous page. 
 

 
Related Documents Page 
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6. TRANSACTION RECORDS 
The Transaction Records screen displays all the Deposit Account transactions made by a 
Customer within the E-Filing System.  This screen also allows you to view records of 
transactions made from the last month up to a year ago.  This is useful for keeping track of 
your deposit accounts and their remaining balance.  
 

6.1 VIEWING TRANSACTION RECORDS 

 
Instruction  
1. Go to the E-Filing Home page and log in using your User Name and Password (see 

"Login" for details). 
 
2. From E-Filing menu, click Transaction Records.  
 

 
Transaction Records 

 
Note: Transaction records are sorted by Transaction Date/Time in descending order, and 
by Form Name and Your Reference in ascending order. 

 
3. By default, the Transaction records for the last month are shown. Select a period in the 

Show Transaction Records from previous drop down list to display Transaction records 
for the following time period: 

• 1 month  
• 3 months 
• 6 months 
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• 9 months 
• 12 months  

 
4. The Deposit Account No. drop down list contains all the deposit account nos. of the 

Customer.  By default, the Transaction records of the first deposit account in the list are 
shown.  Select a deposit account no. in the Deposit Account No. drop down list to display 
Transaction records paid for that deposit account. 

 
5. If you wish to review the application that you paid for together with its attached 

documents click the form name under the Form Name column. 
 
6. To view the batch of applications submitted related to a transaction record, click the 

Submission ID reference link for that record.  
 
Note: After clicking the Submission ID reference link, the Submission Details screen is 
displayed. (see "Previewing and Submitting Uploaded Applications" in chapter 3 for 
details) 
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7. ADMIN USER GUIDE 
The Admin User in E-Filing System is a user who has authority to manage the user accounts 
under a Customer ID.  Only the Admin User can apply for additional User Account(s), 
suspend / reactivate User Account(s) under the same Customer ID and enable User Account(s) 
to receive automatic e-mail notifications when a new letter/notice is added to the Electronic 
Mail Box.   
 

7.1. APPLICATION FOR ADDITIONAL USER ACCOUNTS 

The User Account Application page is used to apply for more User Accounts under a 
Customer ID.  
 
Instruction 
1. Go to the E-Filing Home page and click Downloads. 
 
2. Under "Section A. Application Forms for e-Filing Services" in Downloads page, click 

Application for e-Filing Services - User Account. Accomplish the Application for 
Additional User Account Form and convert it to XML file(see "Application for Electronic 
Filing Services" for details).  
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3. Sign the XML application form twice:   

3.1. First, sign the XML application form using the certificate of the Web User you 
want to add.     

3.2. Then, sign the XML file again using the Admin User certificate (the certificate used 
to sign the Application for e-Filing Services Form).     
 
Note: You can use the offline signing component provided at the Downloads screen 
(see "Introduction to Electronic Submissions" for details).  You can also sign the 
file online as discussed in instruction no. 8. 
 

4. Log in to the E-Filing System as Admin User. 
 
5. From the E-Filing menu, click Admin User Page.  

 

 
Admin User Page - User Account Application tab 

 
6. Go to User Account Application tab.  
 
7. In Application Filename, enter the location and file name of the XML file you prepared 

or, click Browse, then find and select the XML file from the dialogue box.  
 
8. To upload the XML file, you can perform any of the following steps: 
 

8.1. If the XML file has already been signed with the Web User and Admin User's 
certificate, click Upload. 

8.2. If the XML file has been signed only with the Web User's certificate, click Sign & 
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Upload and sign the file using the Admin User's certificate. 
8.3. If the XML file has not been signed by both Web User and Admin User’s 

certificate, click Sign & Upload.  Sign the file using the Web User certificate first; 
and then click Sign & Upload again to sign using the Admin User's certificate.  
 
Note: An error will be displayed after signing  an unsigned application for the first 
time in the User Account Application page, informing you that the application must 
contain two signatures. 
 
Note: After uploading, the system will extract the application details from the XML 
file, and display the data extracted on the Confirmation page.  
 

9. On the Confirmation page, check if data is correct.  
 

 
Web User Account Application Confirmation 

 
Note: If you want to change the data as displayed in the Confirmation page, click 
Return to Previous Screen and either change the original (not signed) XML file or 
change the Web User Account Form and generate a new XML file.  You can repeat the 
instructions starting from step 2 or 3 to step 9.  
 

10. Click Submit.  
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Web User Account Application Submission Message 

 
Note: IPD will need time to process your application.  Once the application is approved, 
you will receive an acknowledgment e-mail at the e-mail address you specified.  
 
Note: Two acknowledgment e-mails will be sent: one for the web user with the username 
and password and another for the Admin User with the user name of the new web user. 
Use the User Name and Password to log into the system.   
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7.2. SUSPENDING / REACTIVATING USER ACCOUNTS 
 
Instruction 
1. Log in to the E-Filing System as Admin User.  
 
2. From E-Filing System menu, click Admin User Page. 

 
Note: User Account tab is displayed by default when Admin User Page is opened.  
 

3. On User Account tab, suspend/reactivate a user account:  
3.1. Tick the check box under Suspended? to suspend a user account.  
3.2. Un-tick the check box under Suspended? to reactivate a previously suspended user 

account.  
 
Note: Suspended User Accounts cannot login to the E-Filing System.  
 

 

 
Admin User Page - User Account tab 

 
4. Click Save.  
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7.3. E-MAIL NOTIFICATION 

Instruction 
1. Log in to the E-Filing System as Admin User.  
 
2. From E-Filing System menu, click Admin User Page. 

 
Note: User Account tab is displayed by default when Admin User Page is opened.  
 

3. On User Account tab, activate e-mail notification:  
3.1. Specify the e-mail address of the user account to which the notification mail will be 

sent. 
3.2. Tick the check box under Email Notification to activate this feature. Un-tick to 

deactivate it. 
 
Note: By default, the Email Notification check box is un-ticked. 
 

4. Click Save. 
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8. IE 8 AND IE 10 32-BIT ENVIRONMENT CONFIGURATION 
The following steps are necessary for E-filing Users who are using Internet Explorer 8 and 
Internet Explorer 10. Note that only the 32-bit versions of the Internet Explorer will be 
supported. You can determine the version of the Internet Explorer used by checking the 
details in the “About Internet Explorer”. 
 

 
 

8.1. SETUP FOR INTERNET EXPLORER 8 (IE 8) 

Note: Some workstations may have both 32-bit and 64-bit Internet Explorer 8 installed. The 
32-bit version of the Internet Explorer can be found in C:\Program Files(x86)\Internet 
Explorer. 
 
8.1.1 Adding E-filing as a Trusted Site 

 
Instruction 
1. Open Internet Explorer 8. 
 
2. Go to Tools menu and select Internet Options. 
 
3. In the Internet Options window, go to Security tab. 
 
4. In the "Select a zone to view or change security settings", click on Trusted Sites. 
 
5. Click Sites to display the Trusted Sites window. Input "https://iponline.ipd.gov.hk" in 

Add this website to the zone. 
 
6. Click Add The value must be inserted into the Websites list at the bottom. 
 
7. Click Close to return to Internet Options window. 
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8.1.2 Set Security Level 

 
Instruction 
8. In Internet Options window, Security tab. Check that Trusted Sites is currently 

selected. 
 
9.  Check the current Security Level for this zone. If the current value is set to "Custom", 

then click Default level to display the security level options. 
 
10. In the displayed security level control. Move the slider to the Medium-low setting. 
 
11. Click Apply. 
 

 

9 
10 
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8.1.3 Disable Protected Mode 

 
Instruction 
12. In Internet Options window, Security tab. Check that Trusted Sites is currently 

selected. 
 
13. Check the status of the Enable Protected Mode checkbox. If the checkbox is currently 

"ticked" then un-tick the checkbox and click Apply. 
 
14. Click OK then restart the Internet Explorer to apply the changes. Note when 

restarting that all currently open Internet Explorer windows must be closed. 
 

 

13 
14 
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8.1.4 Additional steps for ActiveX and DLL files Installation 

 
If the above steps have been completed successfully and the E-filing system still prompts an 
error message “ME10000 : The XML Signer Component is not installed properly, or 
your current security settings do not allow ActiveX controls to run”, then please perform 
the following setting before accessing E-filing system to install the necessary ActiveX and 
DLL files. 
 
Instruction 
1. From Windows Start Menu, access Control Panel. 
 
2. Click User Account, options regarding the User Account Settings will be displayed. 
 
3. Click Change User Account Control settings. User Account Control Settings window 

will be displayed. 
 
4. Set the control to Never notify. Click OK. 
 
5. Restart the computer to apply the changes.  
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8.1.5 Additional steps for processing in Offline Signing Tool in IE8 

 
Instruction 
1. Click on pop-up message “To help protect your security, Internet Explorer has 

restricted this webpage from running scripts or ActiveX controls that could access 
your computer. Click here for options…” once the Offline Signing Tool has been 
opened.  

 
2. Click Allow Blocked Content… in the prompted options menu. 
 
3. Click Yes in the prompted Security Warning message such that ActiveX can be processed 

in the Offline Signing Tool. 
 

 

 1   2 
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8.2. SETUP FOR INTERNET EXPLORER 10 (IE 10) 

 
8.2.1. Adding E-filing as a Trusted Site 

 
Instruction 
1. Open Internet Explorer 10. 
 
2. Go to Tools menu and select Internet Options. 
 
3. In the Internet Options window, go to Security tab. 
 
4. In the "Select a zone to view or change security settings", click on Trusted Sites. 
 
5. Click Sites to display the Trusted Sites window. Input "https://iponline.ipd.gov.hk" in 

Add this website to the zone. 
 
6. Click Add. The value must be inserted into the Websites list at the bottom. 
 
7. Click Close to return to Internet Options window. 
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8.2.2. Set Security Level 

 
Instruction 
8. In Internet Options window, Security tab. Check that Trusted Sites is currently 

selected. 
 
9. Check the current Security Level for this zone. If the current value is set to "Custom", 

then click Default level to display the security level options. 
 
10. In the displayed security level control. Move the slider to the Medium-low setting. 
 
11. Click Apply. 
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8.2.3. Disable Protected Mode 

 
Instruction 
12. In Internet Options window, Security tab. Check that Trusted Sites is currently 

selected. 
 
13. Check the status of the Enable Protected Mode checkbox. If the checkbox is currently 

"ticked" then un-tick the checkbox and click Apply. 
 
14. Click OK then restart the Internet Explorer to apply the changes. Note when 

restarting that all currently open Internet Explorer windows must be closed. 
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8.2.4. Disable Enhanced Protected Mode 

 
Instruction 
15. In Internet Options window, go to Advanced tab. 
 
16. Check the Security list under Settings. 
 
17. Check the status of the Enable Enhanced Protected Mode* checkbox. If the checkbox 

is currently "ticked" then un-tick the checkbox and click Apply. 
 
18. Click OK then restart the computer to apply the changes. 
 

 

15 
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8.2.5. Additional steps for ActiveX and DLL files Installation 

 
If the above steps have been completed successfully and the E-filing system still prompts an 
error message “ME10000 : The XML Signer Component is not installed properly, or 
your current security settings do not allow ActiveX controls to run”, then please perform 
the following setting when accessing E-filing system to install the necessary ActiveX and 
DLL files. 
 
Instruction 
1. From Windows Start Menu, access Control Panel. 
 
2. Click User Account, options regarding the User Account Settings will be displayed. 
 
3. Click Change User Account Control settings. User Account Control Settings window 

will be displayed. 
 
4. Set the control to Never notify. Click OK. 
 
5. Restart the computer to apply the changes.  
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6. On “Internet Explorer”, right click and choose "Run as administrator".  
 
7. Accessing E-filing system to install the necessary ActiveX and DLL files. 
 

 
 

6 
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8.2.6 Additional step for processing in Offline Signing Tool in IE10  

 
Instruction 
1. Click Allow blocked content in the pop-up message “Internet Explorer restricted this 
webpage from running scripts or ActiveX controls.” once the Offline Signing Tool has 
been opened. 
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